
GAB8
10 x 50W Class D 7.3 / 5.3 
Con�gurable Audio Ampli�er Board -
TPA3244 

USB Type-C 

152.40 (w) x 114.30 (d) x 28.60 (h) mm

443g

Audio Input

Product Size

Weight

The GAB8 is a compact and powerful audio ampli�er board that is
designed for game machine applications with a total output power of
500 watts (10 x 50 W).  

Features:
• 7.1 USB UAC2.0 Codec as Audio Input.
• Versatile Output Modes: Choose from 7.3 or 5.3 Con�gurations.
• Supporting External Plug-and-Play Modules as Daughter Boards.
• Higher Output Power to 75W Peak with Fan Installed and DC 24V Supply.

Parameters:
Supply Voltage

Output Channel

(15V to 30V) Mini-Fit Jr 2x2 CKT 

Mini-Fit Jr 2x7 CKT

50W peak per Channel without FanOutput Power

 

152.40

11
4.

30

R3.00

Ø3.80

22.50

Audio Output
Power Output

Volume Control
Potentiometer 

Audio Output

Power Output
Power Supply
Min 24V, 200W

Fan Connector
USB Type-C Audio

152.40
1.60

28
.5

0

Audio 7.3 / 5.3 SystemSystem

Installed
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Mechanical Drawing
(Nominal Dimensions, mm)

114.30

37
.5

0

Control Connector

5.00

5.00

NOTE: The GAB8 ampli�er comes with a standard 15mm fan. 
Upon customer request, a 10mm fan is available at an additional 
cost of $1.57. 



Connectors Layout
GAB8 Modules

2

1

5
4

3

2

 
1. Power Supply
GAB8 supports a wide voltage range of 15V to 30V. It's crucial to connect a compatible power source within this voltage range to ensure the 
board functions correctly. For the best results, a 24V switching power supply is recommended. Refer to [Page 7] of the documentation 
for speci�c power supply recommendations.
2. Audio Output 
Features a 7.3 speaker con�guration, providing audio output for gaming and entertainment needs. 
3. Control
"SHDN" and "MUTE" pins operate on an active low basis; shorting them to GND triggers shutdown or mute mode. 
4. USB Audio  
GAB8 can function as an audio input for the 7.1 USB UAC2.0 codec internal circuit. This feature allows you to connect a wide range of 
audio sources and supporting audio with 24-bit depth and a sampling rate of 48,000Hz, providing studio-quality audio.
5. Fan
A robust heatsink is mounted on GAB8 for heat dissipation. You can connect the fan to a designated port. The fan will activate when the 
heatsink temperature reaches 45°C, ensuring optimal performance, especially during extended use or when operating GAB8 at peak power 
levels.
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• Check that the impedance (ohms) of your speakers matches the GAB8's requirements. Using speakers with the incorrect impedance can 
damage the ampli�er or speakers.
• Be cautious with volume levels, especially when testing or initially setting up your system. Sudden loud sounds can harm your hearing and 
potentially damage your speakers.
• Ensure that GAB8 is properly grounded and connected to a stable power supply. If you are not going to use GAB8 for a long time, be sure 
to disconnect GAB8 from the power supply to prevent any damage or energy wastage.
• If you have children, secure or place the ampli�er out of their reach to prevent accidents and potential damage. 

• Organize and secure cables to prevent tripping hazards and accidental disconnections. Use cable clips or ties to keep wires neat and tidy.
• Place GAB8 securely on a stable surface. Serious damage to this product may result if it falls. Do not allow anything to rest on the GAB8. 
Do not place GAB8 where a person can step or trip on GAB8.
• Place GAB8 in a location with adequate ventilation to prevent heat buildup and prolong the life. Do not place GAB8 near heat sources, or 
in a place subject to direct sunlight, excessive dust, or mechanical shock.
• If the GAB8 is rack-mounted or wall-mounted, ensure that it is securely attached according to the manufacturer's instructions.
• Maintain records of your purchase and warranty information. If you encounter problems or have questions, contact the manufacturer's 
customer support for assistance.

GAB8
User Manual

CAUTION Indicates a potentially hazardous situation which, if mishandled, could 
result in moderate or minor personal injury, and/or property damage.

Precautions
Safety Precautions

Installation Precautions

Start by thoroughly reading the user manual provided with your GAB8 ampli�er. 
It contains essential safety information and guidelines speci�c to your device.

CAUTION: GAB8 does not provide reverse polarity protection. Therefore, extreme caution must be exercised to ensure correct polarity during 
connection.Permanent damage caused by reverse polarity will not be covered under warranty.



JST PH 8 Pin Cable
Please note that this cable is not included as a part 
of the cable accessories. These cables are 
considered standard items and can be purchased 
separately from various retailers or suppliers. 
However, you have the option to purchase 
as part of an accessory bundle.

Wire Kit - Audio Output
Details about the cables 
included as accessories with 
this product can be found in 
the appendix section. 
Refer to [Page 8] for 
information on this included cables.

Output Noise Level A-weighting, USB connection activated L&R - 169 - uV

Parameter Conditions Min. Typ. Max. Units

%-90-10x50W@24V, 4Ohm, 1kHzE�ciency

Ω1643Floating may lead to EMI issues

Nominal Power Requirement 24V power supply recommended 150 750 W

Operating Voltage 4Ω or higher, if resistance 3Ω, use 20V or less 15 24 30 V

W-240-

SHDN short to GND, Signal detected@24V, 0.13AStandby Power

350

GAB8 Audio Performance Parameters

Layout Ports And Control
Connecting the GAB8

+VE -VE
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Refer to the �gure for a 
visual representation of 
the fan connector and the 
correct orientation of the 
cable's positive and 
negative wires. 

Wire Kit - Fan Cable
Details about the cables included as 
accessories with this product can be 
found in the appendix section. Refer to 
[Page 9] for information on this 
included cables.

Wire Kit - Power Cable
Details about the cables included 
as accessories with this product 
can be found in the appendix 
section. Refer to [Page 7] for 
information on this included 
cables.
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USB Type-C Cable
Please be aware that certain cables, while 
essential for use with this product, are not 
provided as part of the cable accessories. 
These cables are considered standard items 
and can be obtained separately from various retailers 
or suppliers. 

Parameter Conditions Min. Typ. Max. Units

Electrical & Audio Performance Parameters
GAB8 Electrical Performance Parameters

Minimum Load Impedance

Power Consumption 1/4 of max output power @4Ω,1kHz,24V

W
12.7

3.12 --

--

SNR

THD+N

10x50W@4Ohm, A-weighting

1W@4Ω, 1kHz, / CH 
10W@4Ω, 1kHz, / CH

Idle Power MUTE short to GND, Signal detected@24V, 0.53A

dB

%

101

0.18

0.14

mV-10--DC O�set

50W@4Ω, 1kHz, / CH 0.69

-

-

-
-

-

-
-

-



Abbreviations used Functions

Note: When you connect only one rear speaker, place the rear speaker directly 
behind the listening position.

As the subwoofer (SUB) does not emit highly directional signals. you can place it wherever you want.

FL
FR
CEN
SSL
SSR
RL
RR
SUB

Front Left Speaker
Front Right Speaker
Center Speaker
Side Surround Left Speaker
Side Surround Right Speaker
Rear Left Speaker
Rear Right Speaker
Subwoofer

Produces stereo sounds
from front left/right channel
Produces vocal sounds from center channel
Produces sounds from side surrounds
left/right channel
Produces sounds from
rear left/right channel
Produces LFE (low frequency e�ect) channel 
sounds and reinforces bass parts of other channels

Speaker Con�gurations

Names And Function of Each Speaker

Location of Each Speaker

Speaker Name

7.1-Channel Speaker System 5.1-Channel Speaker System
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Front speakers
Rear

speakers

13 1411 12108 9

6 74 531 2

13 1411 12108 9

6 74 531 2

Subwoofer

Side
Surround speakers

Subwoofer

Speaker Con�gurations
7.3-channel speaker system 

Note: A 7.3 system consists of seven main speakers (Front Left - FL, Center - CEN, Front Right - FR, Side Surround Left - SSL, Side Surround Right - SSR, Rear Left - 
RL, Rear Right - RR) and three subwoofers. In this con�guration, each speaker should be connected individually to the audio source using appropriate wiring connection. 
Additionally, three subwoofers are employed for enhanced bass performance. In contrast, a 7.1 audio system includes the same seven main speakers as the 7.3 
con�guration, but it utilizes only one subwoofer dedicated to handling bass frequencies. 

*If you connect only one rear speaker, 
connect it to the L (+/–) terminals. 

UMGAB8-04

*Prior to connecting any cables, 
ensure that the power cable is 
not connected. This is crucial for 
safety during the setup process.

*Before attaching speaker cables 
to the speaker terminals, double-
check that wires from the speaker 
cables are not in contact with 
each other. This precaution 
helps prevent electrical 
interference and ensures 
proper connectivity.

GAB8
User Manual

FL FR

CEN

RRRL

SSL SSR

SUB FL FR

CEN

SSL SSR

SUB

FR

CEN

SSR RRFL RLSSL

NOTE: To con�gure your audio system for a 5.3 speaker setup, it's important to make speci�c adjustments. You will need to remove the Rear Left (RL) and Rear 
Right (RR) speakers that are present in a 7.3 system. Please ensure that you make secure and proper wire connections from the connector to each speaker in 
your chosen con�guration to optimize your audio setup. 
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Connecting Hardware: Connect the GAB8 ampli�er to your PC's USB Type-C port using a Type-C cable. Plug in the power cable to the 
GAB8 ampli�er and connect it to a power source to ensure the ampli�er has power. Connect the speaker cables from all 8 speakers to their 
respective channels on the GAB8 ampli�er to maintain audio balance.

Con�guring Audio Settings: Right-click on the speaker icon in the Windows taskbar or go to the Sound settings in the Control Panel.
Select "GAB8 WONDOM" as the playback device. Click on "Con�gure" under the GAB8 WONDOM device. In the Con�gure window, select 
"7.1 Surround" from the sound format dropdown menu to con�gure audio output for 7.1 channel surround sound. Test audio through your 
PC to ensure that sound is coming from all 8 connected speakers. Under "Advanced sound options," select 24-bit, 48000 Hz Studio Quality.

Enabling 8-Channel Multi-Audio in Audacity:

Open Audacity: Launch the Audacity audio editing software on your
computer.

Enable Advanced Mixing Options: Click on the "Edit" menu at the 
top of the Audacity window to reveal a dropdown menu. From this 
menu, select "Preferences." This will open the Audacity Preferences 
window.Inside the Audacity Preferences window, look for the 
"Import/Export" section in the left sidebar.Within this section, you will 
�nd various preferences related to importing and exporting audio �les. 
Locate and tick the checkbox labeled "Use advanced mixing options." 
Enabling this option is crucial for working with multiple audio channels 
e�ectively.

Prepare Your Audio File: Before you can enable 8-channel multi-
audio, you need to have an audio �le with 8 separate audio tracks or 
channels. Ensure that your audio �le is ready for importing into 
Audacity.

Import the 8-Channel Audio: Go back to the main Audacity window. 
Use the "File" menu to select "Import" and then "Audio." Locate and 
select your prepared 8-channel audio �le from your computer's 
storage. Audacity will import this �le, recognizing it as an audio track 
with multiple channels.

Con�gure Each Channel: After importing the audio �le, you will see 
it represented as a single track in Audacity. Click on the dropdown 
arrow near the track's title to reveal the individual channels or tracks. 
You should see all 8 channels listed separately. Con�gure each 
channel according to your preferences. You can adjust volume levels, 
apply e�ects, or make any necessary edits to individual channels.

Export as WAV: Once you have con�gured the channels to your satisfaction, it's time to export the audio as an 8-channel WAV �le. Go to 
the "File" menu and select "Export" and then "Export Audio." Choose a location on your computer to save the �le and provide a name for it.

Select the Appropriate Format: In the export settings dialog, make sure to save as type “WAV (Microsoft)” and select on encoding 
dropdown "Signed 24-bit PCM" as the export format. This format is suitable for preserving high-quality audio. Click the "Save" button to 
con�rm your export settings and save the audio �le.

Playback in Windows Media Player: Once the 8-channel audio �le is saved, you can open it in Windows Media Player or any other 
compatible media player. When played, each channel will be heard separately, providing an 8-channel audio experience.In this setup, it's 
important to note that all speakers will act as full range, capable of reproducing the entire audio frequency spectrum,

GAB8
User Manual

Speaker Con�gurations
Connecting to 7.1 Surround System and Setting up an 8-Channel Multi-Audio System:

NOTE: You can also export a track into Audacity and set their preferences for each channel to play 7.1 LPCM, allowing for further customization of the audio 
playback. After importing the audio �le, you will see it represented as a single track in Audacity. Click on the dropdown arrow near the track's title to reveal the 
individual channels or tracks. Ensure that you have 8 channels available for playback. These steps should help you set up and con�gure your GAB8 ampli�er 
for 7.1 surround sound on your PC.  

NOTE: Multi-audio system typically requires a speci�c number of speakers to match the number of audio channels. However, if the you has only 2 or 3 speakers, 
you can still work with limitations to enjoy multi-audio content.In Audacity, identify the channels or tracks in the audio content and assign them to the available 
speakers as per the your's preference. For example, if there are 5 audio channels but only 2 speakers, you can assign 3 channels to the �rst speaker and the
remaining 2 channels to the second speaker. Audacity provides the �exibility to customize channel placement.



When you're considering buying our product in large quantities, here's what 
you need to know:

Bulk Purchase Rights: The number of products you can buy at once is 
determined by your single purchase, not your total annual purchases.
Customization and Pricing: If you wish to customize our product, the options 
and costs depend on the quantity you purchase in a single 
transaction.
Retail Purchases: For individual purchases, you can only buy our product 
through our authorized distributor platforms. Please note that the listed
prices on these platforms may change over time.
Bundled Pricing for 100 Units: When you buy a minimum of 100 units in one 
transaction, you may qualify for a special bundled price for that 
quantity.
Customization for 500 Units or More: If you're planning to purchase 500 units or 
more, you have the option to customize various aspects of the product. This 
includes changes to the product's appearances, such as color, size, logo, cable 
length, and packaging materials. Additionally, you can customize the �rmware 
by altering the product string. We also o�er a range of services, which encom-
pass wire kit, panel, cabinet, and mount bracket design. To explore these 
customization options further, please contact us via email for detailed informa-
tion and to discuss your speci�c 
requirements.
Standard Price List: For orders of 500 units or more, you can request our 
standard price list by reaching out to our customer support.
Pricing for Bulk vs. Bundled: It's important to note that the price for buying in 
bulk is not signi�cantly di�erent from the bundled price for 100 
units.
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Purchasing Rights

Origin and Design 
Location 

Warranty Terms and Product 
Usage Restrictions
Wondom products come with a one-year warranty starting from the date 
of purchase. Customers are responsible for the cost of returning the 
goods to the seller, and by making a purchase, you agree to this condition. 
Due to the nature of DIY products, visible damage or use on screw holes or 
tinning of solder pads directly invalidates the warranty. Damage caused by 
the use of incorrect power sources, such as 
exceeding the speci�ed voltage range or reverse polarity, is not covered 
under warranty. All Wondom products undergo thorough testing before 
shipment. We do not accept bulk returns after a bulk purchase. If you are 
unsure of the quantity you need, please purchase the appropriate quantity 
as needed. All Wondom products are intended for DIY use only and do not 
support any industrial applications. The rated operating
temperature range is -10-50°C. 

3F, Building F6, No. 9, Weidi Road,
Xianlin, Qixia Dist., Nanjing, China.
+86(25)8526-0046  |  info@sure-electronics.com

To view our products and purchase, 
please visit our website:
store.sure-electronics.com

58-7-2, Jalan Cantonment, 
Wisma Fortune Heights, 10250, Pulau Pinang, Malaysia.
+60(4)2189323  l  info@wondom.com
(Please use phone calls or email instead of WhatsApp 
or iMessage.) 

Distributed by:

Designed by:

www.wondom.com

store.sure-electronics.com

Sure Electronics Co., Ltd.
Professional Industrial Audio Solu�on Provider

Wondom Audio Technology
All Wondom products are designed, manufactured, assembled, and 
shipped from China. The products' country of origin is China. We do not 
provide any services for sales, shipping, or manufacturing from other 
regions.
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Accessories

Usage:
Secure and prevent 

any unintended 
movement of the 
USB Type-C cable.

USB Type C
Cable Size:
<Ø5mm 

USB Type C
Cable Clip

Usage:
Sissipate heat from 
the GAB8's heatsink,

ensuring optimal 
performance during 

extended use.

Size:
60x60x10(mm)

Wire Length:
290mm±20mm  

Fan

Usage:
Control Function.

Length:
The cable length 

may vary and 
depends on 
your speci�c 

requirements. 

JST PH 4 Pin
Cable

Usage:
Mounting and 

securely holding the 
GAB8 in place.

Size:
6.0”x4.5” 

L Bracket

Usage:
Audio output for 

gaming and 
entertainment needs.

Length:
200mm±10mm 

 

Audio Output
Cable

Usage:
Connect to 

compatible power 
source.  

Input:
Voltage range of 

15V to 30V

Length:
500mm±50mm 

 

Power Cable

Supplied Accessories Optional Accessories

Usage:
Simpli�es the 
connection of 

GAB8's audio output 
cable to individual 

speaker cables.

Size:
 38.4mmx13.4mm 

x14.5mm  

Universal Wire
Connector
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